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Overview
The Vantage Social Media Connector enables digital media producers to quickly and easily 
publish their digital media assets to Facebook, YouTube, Google+, Twitter, Vimeo, and LinkedIn 
using one or more Deploy actions within a Vantage workflow. 

In addition to uploading the media files or media links to social media sites, the Social Media 
Connector publishes metadata, such as description, location and other pertinent information, 
which reduces manual steps that are sometimes needed after upload. Some of the Social Media 
endpoints also support uploading caption or subtitle files and thumbnail files.

Deployment Options
There are two deployment operation types of Social Media workflows. Operator assisted and 
fully automated.

1. Operator Assisted—Operator assisted provides users with tools to edit metadata and 
video so that operators who do not have access to Vantage for directly submitting jobs to 
workflows (such as social media marketing teams) can choose their media and define their 
messaging in a user interface. 

For examples of operator assisted workflows see the descriptions below: Submit Using the 
Vantage Workflow Portal, Using the Vantage Workflow Portal, and Submit from Live or Cap-
ture.

2. Fully Automated—Fully automated operation receives media and metadata from 
workorders, associated metadata files (such as XML), or API submissions, and provides a 
method for publishing pre-formed content and metadata. 

For examples of fully automated workflows see the descriptions below: Example Workflow: 
Social Media—Workorder and Example Workflow: Social Media—Watch and Associate.

Requirements
The following are the requirements to enable publishing to YouTube, Google+, Twitter, Vimeo, 
and LinkedIn using the Vantage Social Media Connector. 

Software
• Vantage 6.3 Update Pack 5 or 7.0 or later and Vantage Social Media Update 6.3.950.190955 

or later:

– A valid license that includes the Vantage Social Media Connector. 

– Additional Vantage licensing requirements depending on your workflow 
configuration. See Workflow Description.

• Social media accounts with appropriate user credentials. See additional account informa-
tion below.

If you do not currently have the correct Vantage version, you can download it from Telestream 
at telestream.net and request a license that includes the Vantage Social Media Connector.

http://www.telestream.net
http://www.telestream.net
http://www.telestream.net
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Required .NET Framework Updates
Publishing to YouTube and Facebook requires .NET 4.5 or later, and publishing to Vimeo, 
requires .NET 4.5.2 or later. To ensure full functionality of the Social Media action, you should 
install .NET 4.5.2. Follow the steps below to determine your current .NET version, and if 
necessary, update to the correct .NET version. 

1. To check which version of .NET is installed on your system, follow these steps (or see this 
Microsoft suppor page: https://support.microsoft.com/en-us/kb/318785):

a. Right-click Start, select Run, and type regedit in the Open field of the Run window.
b. In the Registry Editor left panel, expand the list to this location: 

HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > .NET Framework Setup > NDP > v4
c. Click the FULL and CLIENT folders, and check the “Release” number. 
d. The Release number for 4.5.2 is 379893. Your Release number should be equal or greater.
e. Follow the steps below to install a newer version of .NET, if necessary.

2. Click this link to download an update to .NET 4.5.2 for Windows Server 2008 R2 or 2012 R2: 
https://support.microsoft.com/en-us/kb/2901907.

3. Click Download. The next page opens.

4. Click Save File from the popup, or Cancel and select item 3 from the list and click Download.

5. Locate and launch the downloaded installer file by double-clicking it. Installation begins.

6. When the installation completes, restart your machine to finish the update.

https://support.microsoft.com/en-us/kb/2901907
https://support.microsoft.com/en-us/kb/318785
https://support.microsoft.com/en-us/kb/318785


Requirements Page 4

Limitations
• Each Social Media Connector license allows up to four (4) concurrent file uploads to social 

media accounts.

• This app note describes the Vantage Social Media Connector for 6.3 UP5, 
version 6.3.950.190955. Features may differ if you have an earlier or later version.

• Facebook was added with Vantage 7.0. You must have version 7.0 and the 7.0 Social Media 
Connector if you need Facebook connectivity.

• Telestream does not contract with Facebook, YouTube, Google+, Twitter, Vimeo, or LinkedIn 
for the use of this product. Before you use the product, you will need to create your own 
Facebook, YouTube, Google+, Twitter, Vimeo, and LinkedIn accounts. Then use the Vantage 
Social Media Connector to post to your accounts using your credentials. 

Support
• The Vantage Social Media Connector can be installed as part of a new Vantage standalone 

or array installation, or it can be added to an existing Vantage domain. 

• Telestream provides online and telephone support for Vantage and the Vantage Social 
Connector. See http://www.telestream.net/telestream-support/vantage/support.htm for 
details.

• For issues with Facebook, YouTube, Google+, Twitter, Vimeo, or LinkedIn, visit their web site 
for contact and support information. Telestream does not provide support for problems 
posting to the site.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
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Configuring the Social Media Connector 
The Vantage Deploy action contains a social media deployment type for Facebook, YouTube, 
Twitter, Vimeo, and LinkedIn. Each of these deployment types allows you to upload media (or 
supply a media link) and associated metadata to each type of social media account. 
Accordingly, all social media workflows are built around the Vantage Deploy action.

The following steps provide an overview of how to create a social media workflow using an 
origin action, a Flip action, and a Deploy action. For more details on specific workflows refer to 
the workflow examples that follow later in this document.

To create simple social media workflows in Vantage, follow these steps:

1. Add an origin action that will acquire the media file you want to process and post. Origin 
actions are Watch, Receive, Workorder, and Camera Ingest.

a. Configure the origin action as required to find and import a media file. Setup of each 
origin action type will differ, depending on which origin type is required.

b. Within the origin action apply a nickname to the incoming file, such as Original.

2. Add a Flip Action and connect it to the origin action. The required media file specifications 
will differ depending on the social media site's media requirements. Your account type may 
limit the video duration, file size, or amount of space consumed. Review these restrictions 
by visiting each respective site’s media policies. When configuring the Flip action follow 
these guidelines:

Facebook—Use a Flip action in your workflow to transcode your media file to an output 
file type supported by Facebook. For guidance in uploading videos to Facebook click this 
link: Help Center > Videos > I want to add a video I've edited to Facebook.

– Recommended formats: MOV or MP4 files containing H.264 video and AAC audio. 
Many other formats are also available.

– File size: 4 GB or less

– Aspect ratio: No larger than 4000 pixels wide and divisible by 16 pixels

– Frame rate: 30 fps or lower

– Audio: stereo audio with 44,100 sample rate

– Length: 120 minutes or less.

YouTube—Use a Flip action in your workflow to transcode your media file to an output 
file type supported by YouTube. For video upload specifications for YouTube go to:

YouTube video specs— https://support.google.com/youtube/answer/1722171

– Recommended formats: MP4 container, H.264 video, and AAC-LC audio. 

– File size: 4 GB or less

– Aspect ratio: No larger than 4000 pixels wide and divisible by 16 pixels

– Frame rate: progressive 24, 25, 30, 48, 50, or 60 fps (other rates also acceptable)

– Aspect Ratio/Resolution: 16:9/360p, 480p, 720p, 1080p, 1440p, 2160p

– Bitrate: (see posted bitrate table for details)

– Audio: stereo audio or stereo + 5.1 at 96 or 48 kHz sample rate

– Length: 120 minutes or less.

https://support.google.com/youtube/answer/1722171
https://www.facebook.com/help/1041366099316573
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Vimeo—Use a Flip action in your workflow to transcode your media file to an output file 
type supported by Vimeo. For video upload specifications for Vimeo go to:

Vimeo video specifications— https://vimeo.com/help/compression

– Recommended formats: H.264 or Apple ProRes 422 (HQ) video, and AAC-LC audio. 

– File size: Limits depend on purchased plan options

– Resolution: wide range from SD 360 x 640 to 4096 x 2048 4K Stereoscopic

– Frame rates: 23.98, 24, 25, 29.97, 30, 50, 59.94, or 60 fps (other rates also acceptable)

– Bitrate (Mbps): SD 2-5, 720p 5-10, 1080p 10-20, 2K 20-30, 4K 30-60

– Audio: stereo audio, 320 kbits/s data rate, 48 kHz sampling

Twitter—Use a Flip action in your workflow to transcode your media file to an output file 
type supported by Twitter, using these specifications:

Twitter video specifications—https://dev.twitter.com/rest/media/uploading-media

– Video container and codec: MP4 with H.264 or x264

– Video dimensions: between 32x32 and 1280x1024

– Duration: 0.5 to 30 seconds per Twitter requirements (not limited by Vantage)

– Aspect ratio: between 1:3 and 3:1

– Frame rate: 40 FPS or lower

– Maximum bitrate: 25 Mbps

– Maximum file size: 15 MB per Twitter requirements (not limited by Vantage)

– Must not have open GOP

– Must use Progressive scan (no interlacing)

– Must have 1:1 pixel aspect ratio

– Audio should be mono or stereo

– Audio must be AAC with Medium Complexity profile. High-Efficiency AAC is not 
supported.

LinkedIn—LinkedIn does not support direct media file uploads. When posting to 
LinkedIn include a link to media uploaded to YouTube, Vimeo or another media site. See 
the YouTube and LinkedIn workflow examples below.

3. Add a Deploy action to the workflow to deploy the output of the Flip action to the 
appropriate social media site. Setting up the Deploy action consists of filling in the 
metadata information blanks with details describing the media and the social media's 
account information. 

Metadata can be acquired in multiple ways (described later in this document) and individ-
ual metadata values are saved into their respective Vantage variables. This information 
allows Vantage to log in, post the media (or media link), and set any metadata values asso-
ciated with your post to the social media site. 

4. Activate the workflow and submit media to it. The workflow automatically acquires the 
media file, transcodes it, and logs into the social media account you specified. 

Once logged in, Vantage assigns the Social Media metadata properties based on Vantage 
variables acquired from a Workorder, side car file Transform, API submission, Workflow Por-
tal or the variables default value within the Deploy action and then posts the media (or 
media link) and metadata to the Social Media site.

https://dev.twitter.com/rest/media/uploading-media
https://vimeo.com/help/compression
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These simple steps allow you to use Vantage to automate the process of posting media and the 
metadata about the media. 

For example workflows and details about how to fill in the fields in the Vantage actions they 
use, see the following Workflow Description section of this application note.

Workflow Description
The following sample workflows are available for download at Telestream.net and are 
described in detail later in this application note. These workflows demonstrate how media and 
metadata can be sent to social media sites, using several origin action methods. 

Publish Media to the Social Media Catalog
This workflow publishes content to a Social Media catalog you create using the Vantage 
Management Console. From the catalog, the content can be accessed by a Workflow Portal 
configured to use the Watch Origin workflow shown below.
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Receive Origin

Receive Origin -> Send to Facebook, YouTube, LinkedIn, Vimeo, and Twitter

This workflow is used to transcode incoming media to a format supported by each respective 
social media site, and deliver metadata to these sites. Jobs can be submitted to it from a 
Workflow Portal or directly from the Watch or Workorder Origin workflows described below.

Receive Workflow First Half

Receive Workflow Second Half (input connected to Synchronize output)



Workflow Description Page 9

Watch Origin

Watch origin with associated metadata -> Watch for incoming media and metadata -> 
Forward to Receive workflow

The Watch origin workflow monitors a folder for incoming media and metadata files. Metadata 
is extracted from an XML file and populated into labels and variables. The workflow then 
forwards the media file and metadata to the Receive Origin workflow for processing and 
delivery to social media. 

Workorder Origin

Workorder submits Path to media with associated metadata -> Watch for incoming 
media and metadata -> Forward to Receive workflow

The Workorder origin workflow accepts a CSV formatted Workorder file which contains the 
path to the media file and all associated metadata. The workflow then forwards the media file 
and metadata to the Receive Origin workflow for processing and delivery to social media. 
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Configuring the Deploy Action
The Deploy action delivers the output media file (or URL link) to the social media end-point 
selected: Facebook, YouTube, Vimeo, Twitter, or LinkedIn. 

The Deploy action includes several metadata fields used to populate the corresponding 
information fields describing the post. You can manually type text into these fields describing 
the post each time you run the workflow, or you can use the green button  beside each field 
to assign the field to a variable. Then you can provide the text for the variable using a 
Workorder or associated metadata XML, or by filling in the metadata label fields in a Workflow 
Portal.

To configure the Deploy action, click the Inspector (I) to open it, select the social media end 
point desired from the deployment type list, and configure it for the respective social media 
types:
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Facebook
Using the Deploy Facebook selection, you can deploy media directly from Vantage to 
Facebook.

Media to Deploy—Select the output media nickname of a Flip action you wish to deploy to 
Facebook, for example, Original, Proxy, or a custom nickname, such as FacebookOUT. The 
media file being uploaded must meet Facebook's media file requirements. (See https://
www.facebook.com/facebookmedia/get-started/video for Facebook's video media best 
practices.)

Title—Enter the title of your video, or use the green button to title the video by selecting and 
using a variable, such as the File Name variable. If you leave this blank, Facebook will use the 
name of the source media file as the title. 

Description—Enter the description of the video, or use the green button to tie this field to a 
variable. If you leave this blank, Facebook will leave the description field empty. The maximum 
is 5000 characters and truncates at that number. Spaces count as 2 characters.

Category—Select a category for your video from the category types listed in the drop-down 
menu. These include selections such as Business, Entertainment, Home, News, and so on. 

Privacy Status—Select from the drop-down menu. Choices include Friends of Friends, All 
Friends, Everyone, Custom, and Self.

Embeddable—Check this box to allow your video to be embedded in third party websites. 
Unchecking does not allow embedding.

Captions SRT File—Specifies the nickname, fully-qualified path, or variable pointing to an 
optional closed caption file, which must be in SRT format. SRT files may be generated from a 

https://www.facebook.com/facebookmedia/get-started/video
https://www.facebook.com/facebookmedia/get-started/video
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Vantage Timed Text Flip action or a third-party product. The file name must be in the form of 
<filename>.en_US.srt, where the locale (shown here as US) may be any locale. 

Thumbnail File—Check the box to include a JPEG or PNG thumbnail image of less than 2 MB 
to post. Specify the thumbnail file location using either a Vantage nickname, by browsing, or by 
assigning a variable.

Security Code—Click Log in with Facebook to acquire a security code token providing 
authentication to upload media to a Facebook account. 

Note: During configuration, when you click the Security Code button, this action allows you 
to enter your Facebook login information. When you do this, you are logging into Facebook in 
real time using your credentials. If you receive a note from the social media site that you need 
to enable cookies, you must use Internet Explorer > Tools > Internet Options > Security to set 
the Internet Security level to Medium so that cookies are enabled.

After you login, Vantage receives your login user name and security code tokens for use during 
job processing. These are visible in the Deploy Inspector. You should be using the latest version 
of Internet Explorer, with all Microsoft updates installed, and your computer and firewall must 
be configured correctly to contact the Facebook servers:

When jobs are processed through a workflow using the Facebook Deploy type, the server 
hosting the Vantage Transport service executing this action and the firewall must be 
configured correctly to communicate with Facebook.

After you click Get Security Code, a Facebook sign-in dialog appears within the Inspector 
window. To get a security code, sign into Facebook by entering an Email address and an 
associated Password and click Sign in.
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Facebook advises you that you are giving account access to Vantage.

Next, Facebook asks you who should be able to view the uploaded media and gives you an 
opportunity to choose what you will allow Vantage access to. Make selections and continue 
(click OK).

After you log in, you are returned to the Deploy Inspector window, which now shows your user 
name and security code. Obtaining a security code token is a one-time task during 
configuration or when your account credentials change. The token is stored with the workflow 
for use in logging onto Facebook automatically each time a job runs. 

Important: The Clear Security Information button removes Security Codes from the action. 
Consider using this feature before exporting your workflow to avoid sharing your security 
information, which is visible as clear text in the exported XML file. 
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Notes: 

(1) You can configure Vantage to log into different accounts (to target multiple groups of 
followers) by adding and configuring multiple instances of the Deploy action and Social Media 
Connector in the same workflow. 

(2) If you have trouble clearing your credentials and logging in as a different user after you log 
into Facebook using the Deploy inspector, follow these steps: 

1. Click Cancel instead of Continue As. A message explains how to log in as another user. 

2. Select Click here to go to Facebook to log out. This takes you to your main Facebook page. 

3. Select Log Out from the drop-down menu in the upper right corner. 

4. Close the Deploy inspector Facebook Authentication window. 

5. In the Deploy inspector, click Log in with Facebook again and log in as another user. 

Facebook Output Variables
The Facebook Deploy action can set variables for use in downstream workflow actions.

Command Line—This variable contains a command line for the standalone application.

URL—This variable output contains a direct link to the Facebook video.
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URL for Embedding—This variable output contains the HTML code used to embed your video 
within another web page or document. See Embeddable option above.

HTML embedded code example using URL for Embedding variable:

 <iframe width="640" height="360" src="[URL for Embedding]" framebor-
der="0" allowfullscreen></iframe>

VideoID—This variable contains the Video ID of your Facebook media. The Video ID is a unique 
identifier linked to your video. It can be used to create links or for creating HTML code to embed 
your video within another web page or document.

Thumbnail—This variable output contains a link to a thumbnail JPEG image generated by 
Facebook.

When you’re finished making entries, click Next, and click Finish to save and close the Inspector.

Facebook and Closed Captions
Facebook has a couple of ways to add captions to your videos. If you are creating a Facebook 
video advertisement, you can use a Facebook tool called Power Editor to edit and add captions 
to your video. Search Facebook Help for Power Editor Basics to get more information.

If you are posting a personal video, not an ad, the editing capabilities are simpler. You will need 
to generate an SRT closed caption file for your video from a program such as Telestream’s 
CaptionMaker or MacCaption, or by using the Timed Text Flip action in Vantage. Facebook then 
allows you to add the SRT captions to the video.

Starting with Vantage 7.0 UP2, simply specify a nickname in the Facebook Deploy action that 
represents an SRT file. The SRT file may be generated by Timed Text Flip upstream in the 
workflow, or created by CaptionMaker/MacCaption and brought into the Vantage workflow 
with an Associate action.



Workflow Description Page 16

YouTube 
From your Google YouTube channel set your channel's default settings from the Video Manager 
by selecting Channel > Upload Defaults.

YouTube also allows you to automatically share with other Social Media sites such as Twitter 
and Google+. Click on your Username in the top-right corner of Google homepage, and click 
“YouTube Settings”. From Account Settings select “Connected Accounts” where you can add 
other sites to share with.

Media to Deploy—Select the output media nickname of a Flip action you wish to deploy to 
YouTube, for example, YouTubeOUT. The media file being uploaded must meet YouTube's 
media file requirements. (See https://support.google.com/youtube/answer/1722171 for 
YouTube's recommended encoder settings.)

Title—Enter the title of your video. If you leave this blank, YouTube will use the name of the 
source media file as the title. The maximum is 100 characters.

Description—Enter the description of the video. If you leave this blank, YouTube will leave the 
description field empty. The maximum is 5000 characters and truncates at that number. Spaces 
count as 2 characters.

Tags—The Tags field can contain a list of keyword search terms separated by commas. Tags 
terms may contain spaces. Example: “Nevada City,Telestream,Vantage”. These 
descriptive keywords help people find your YouTube content when they search. YouTube 
Formatting tags can also be added to change the appearance and format of your video within 
YouTube or embedded players. (For details, see https://support.google.com/youtube/answer/
146402.) The maximum is 500 characters, including commas and spaces. If no tags are entered, 
YouTube will leave this field empty.

https://support.google.com/youtube/answer/1722171
https://support.google.com/youtube/answer/146402
https://support.google.com/youtube/answer/146402
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Category—Select a category for your video from the category types listed in the drop-down 
menu. These include selections such as Autos & Vehicles, Comedy, Education, Entertainment, 
and so on. 

When setting the YouTube Category through a variable, API, or Workorder, take care that the 
text you enter exactly matches one of YouTube’s category types, including upper and lower 
case. A mismatch will cause an error. 

Public Stats Viewable—Check the box to allow public access to the video's statistics (views, 
likes, dislikes, etc.). Leaving the Public Stats Viewable box unchecked prevents public access to 
the statistics.

Privacy Status—Select the privacy type for this video from Public, Unlisted, or Private. Videos 
set to Private require the viewer to log in. Those set to Unlisted can be viewed by anyone having 
the video's URL link, but they will not appear in a YouTube search request. Setting the Privacy 
Status to Public allows anyone to view or search for this video.

Location Description—Enter a partial or full street address (formatted as required by the 
country of the location), a city, a country, or a landmark name (such as Yosemite National Park, 
Empire State Building, or Wembley Stadium). YouTube uses the location description to 
determine the geographic latitude and longitude of the location. The Location Description and 
latitude/longitude are retained within the YouTube asset's metadata. If the location, latitude, or 
longitude are not specified or cannot be discovered, YouTube leaves these fields empty.

Recording Date—Enter the date and time when this video was recorded or created.

Captions SRT File—Specifies the nickname, fully-qualified path, or variable pointing to an 
optional closed caption file, which must be in SRT format. SRT files may be generated from a 
Vantage Timed Text Flip action or a third-party product.  

Thumbnail File—Check the box to include a JPEG or PNG thumbnail image of less than 2 MB 
to post. Specify the thumbnail file location using either a Vantage nickname, by browsing, or by 
assigning a variable.

Security Code—Click Get Security Code to acquire a security code token providing 
authentication to upload media to a YouTube channel. 

Note: During configuration, when you click the Security Code button, this action contacts 
Google in real time and, using your credentials, receives security code tokens for use during 
job processing. If you receive a note from the social media site that you need to enable 
cookies, you must use Internet Explorer > Tools > Internet Options > Security to set the 
Internet Security level to Medium so that cookies are enabled.

Use the latest version of Internet Explorer, with all Microsoft updates installed, and your 
computer and firewall must be configured correctly to contact the Google servers:

• accounts.google.com (port 80)

• google.com (port 80)

• ssl.gstatic.com (port 443) 

Enter these URLs into the Internet Explorer Trusted Sites field (or otherwise configure Internet 
Explorer to allow access to these URLs). When jobs are processed through a workflow using the 
YouTube Deploy type, the server hosting the Vantage Transport service executing this action 
and the firewall must be configured correctly to communicate with Google.
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After you click Get Security Code, a Google Sign-in dialog appears within the Inspector window. 
To get a security code, sign into Google by entering an Email address and an associated 
Password and click Sign in.

Next, the YouTube Accounts dialog opens, if multiple accounts are associated with your login. 
Click an account and click OK. 

An Authentication dialog displays, asking you to verify that you are allowing YouTube to access 
your information. Click Allow and then OK to get a security code token. 

Obtaining a security code token is a one-time task during configuration or when your account 
credentials change. The token is stored with the workflow for use each time a job runs. 
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Click OK to return to the main Deploy action Inspector window, and click Next to set up the 
YouTube output variables. 

Note: You can configure Vantage to log into different accounts (to target multiple groups of 
followers) by adding and configuring multiple instances of the Deploy action and Social Media 
Connector in the same workflow. To select a different Google account for each Deploy, select 
accounts from the drop-down menu in the upper right corner of the YouTube Authentication 
dialog. 

Important: The Clear Security Information button removes Security Codes from the action. 
Consider using this feature before exporting your workflow to avoid sharing your security 
information, which is visible as clear text in the exported XML file.
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YouTube Output Variables
The YouTube Deploy action can set variables for use in downstream workflow actions.

Command Line—This variable contains a command line for the standalone application.

URL—This variable output contains a direct link to the YouTube video.

URL for Embedding—This variable output contains the HTML code used to embed your video 
within another web page or document. See Embeddable option above.

HTML embedded code example using URL for Embedding variable:

 <iframe width="640" height="360" src="[URL for Embedding]" framebor-
der="0" allowfullscreen></iframe>

VideoID—This variable contains the Video ID of your YouTube media. The Video ID is a unique 
identifier linked to your video. It can be used to create links or for creating HTML code to embed 
your video within another web page or document.

URL examples:

https://youtu.be/[Video ID]

https://www.youtube.com/watch?v=[Video ID]

HTML Embedded code example:

<iframe width="640" height="360" src="https://www.youtube.com/embed/
[Video ID]" frameborder="0" allowfullscreen></iframe>

Thumbnail—This variable output contains a link to a thumbnail JPEG image generated by 
YouTube.

When you’re finished making entries, click Next, and click Finish to save and close the Inspector.
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YouTube and Closed Captions
Closed Captions can be propagated to YouTube by submitting a transport stream with MP2 
essence and embedded captions as the source file. YouTube extracts and formats the captions 
so that they can be user enabled or disabled in the YouTube player. 

Twitter
The Twitter deployment is used to upload media to twitter.com. You must have a Twitter 
account, enter metadata, and supply the required credentials for authentication to configure 
this action.

Media to Deploy—Select the Media nickname you would like to Deploy to Twitter. The Twitter 
Deploy type does not check for the media file requirements prior to starting the upload. If the 
video being uploaded does not meet Twitter's requirements the Deploy action will fail with an 
error message.

In order to avoid having your video upload rejected by Twitter, use Vantage's Analysis actions 
to analyze the media file prior to the Deploy action. Create a workflow that reports which 
requirement is not within the proper ranges.

Tweet—Enter your Tweet message. The message may include @mentions (directed to a 
particular username), URLs (web addresses) and hashtags. 140 characters is the maximum 
(@mentions and hashtags are included in this count). 

Security Code—Click Get Security Code to acquire a security code token providing 
authentication to upload media to a Twitter account. To acquire a security code you must sign 
into a Twitter account using the account's Username/Email and associated Password. Enter 
these when the Twitter sign-in dialog appears. If you receive a note from the social media site 
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that you need to enable cookies, you must use Internet Explorer > Tools > Internet Options > 
Security to set the Internet Security level to Medium so that cookies are enabled.

After you have signed in, a Twitter Authentication dialog will open. Click Allow and then OK to 
acquire a security code token. This is a one-time requirement during configuration or when 
your account credentials changes. The security code token is stored with the workflow in the 
Vantage database and used each time a job is run.

To sign out or select a different Twitter account, open the drop-down menu in the upper right 
hand corner of the Twitter Authentication dialog.

Important: The Clear Security Information button removes Security Codes from the action. 
Consider using this feature before exporting your workflow to avoid sharing your security 
information, which is visible as clear text in the exported XML file.

Note: After you log in using Vantage, if you have trouble clearing your credentials so you can 
log in as a different user, follow these steps: (1) Click Get Security Code. (2) In the Get Security 
Code window, click your profile picture in the top right corner. (3) Sign out of Twitter. (4) Log in 
as another user. 
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Vimeo
The Vimeo deployment is used to upload media to Vimeo.com. You must have a Vimeo 
account, enter metadata, and supply the required credentials for authentication to configure 
this action.

The type of account you have affects the settings you can make:

Basic account—This option is not available to a Vimeo Basic account user. Do not set Who Can 
Watch This Video to Disable. This results in a failed job and an error in Vantage.

Plus account—Has access to all of the settings and options in the Vimeo Deploy action.

Pro account—Has access to all of the settings and options in the Vimeo Deploy action. In 
addition, a Pro account user can log into Vimeo and under Preference settings, place the 
account into Private mode. When Vantage interacts with Vimeo using a Pro account in Private 
mode, the first four options in the Who can watch this video? setting are disabled.

Note: When you click the Security Code button (described below), this action contacts Vimeo 
in real time and, using your credentials, receives a security code token for use during job 
processing. If you receive a note from the social media site that you need to enable cookies, 
you must use Internet Explorer > Tools > Internet Options > Security to set the Internet 
Security level to Medium so that cookies are enabled.

You should be using the latest version of Internet Explorer, with all Microsoft updates installed, 
and your computer and firewall must be open to these ports:
 - api.vimeo.com (port 443)
 - vimeocdn.com (port 443)
 - telestream.net (port 80). 
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Media to Deploy—Select the Media nickname you would like to Deploy to Vimeo. The media 
file being uploaded must meet Vimeo's media file requirements. See Vimeo's video 
compression guidelines at: https://vimeo.com/help/compression. 

Title—Enter the title of your video. If you leave this blank, Vimeo will use the name of the 
source media file as the title. The maximum is 100 characters.

Description—Enter the description of the video. If you leave this blank, Vimeo will leave the 
description field empty. The maximum is 5000 characters and truncates at that number. Spaces 
count as 2 characters.

Tags—The Tags field can contain a list of keyword search terms separated by commas. Tags 
terms may contain spaces. Example: “Nevada City,Telestream,Vantage”. These 
descriptive keywords help people find your content when they search. 

Category—Select a category that generally describes your video from the category types 
listed in the drop-down menu. 

When setting the YouTube Category through a variable, API, or Workorder, take care that the 
text you enter exactly matches one of YouTube’s category types, including upper and lower 
case. A mismatch will cause an error. 

Who can watch this video?—Select one of the available options from the drop-down menu. 
Anybody, Nobody, Contacts, Users, Unlisted, or Disable.

Who can comment on this video?—Select one of the available options from the drop-down 
menu. Anybody, Nobody, or Contacts.

Where can this video be embedded?—Select one of the available options from the 
drop-down menu. Anywhere or Nowhere.

Can anyone download this video?—Check this box if you want the video to be able to be 
downloaded.

Allow anyone to add this video to Albums, Channels, or Groups—Check this box to allow 
the video to be added to Albums, Channels, or Groups. 

Captions SRT File—Specifies the nickname, fully-qualified path, or variable pointing to an 
optional closed caption file, which must be in SRT format. SRT files may be generated from a 
Vantage Timed Text Flip action or a third-party product.  

Thumbnail File—Check the box to include a JPEG or PNG thumbnail image of less than 2 MB 
to post. Specify the thumbnail file location using either a Vantage nickname, by browsing, or by 
assigning a variable.

https://vimeo.com/help/compression
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Security Code—Click Get Security Code to acquire a security code token providing 
authentication to upload media to a Vimeo account. To acquire a security code you must sign 
into a Vimeo account using the account's username, email, and associated password. Enter 
these when the Vimeo sign-in dialog appears. If you receive a note from the social media site 
that you need to enable cookies, you must use Internet Explorer > Tools > Internet Options > 
Security to set the Internet Security level to Medium so that cookies are enabled.

After you have signed in, a Vimeo Authentication dialog will open. Click Allow and then OK to 
acquire a security code token. This is a one-time requirement during configuration or when 
your account credentials changes. The security code token is stored with the workflow in the 
Vantage database and used each time a job is run.

To sign out or select a different Vimeo account, open the drop-down menu in the upper right 
corner of the Vimeo Authentication dialog.

Important: The Clear Security Information button removes Security Codes from the action. 
Consider using this feature before exporting your workflow to avoid sharing your security 
information, which is visible as clear text in the exported XML file.
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Vimeo Output Variables
The Vimeo Deploy action can set variables for use in downstream workflow actions.

Command Line—This variable contains a command line for the standalone application.

URL—This variable output contains a direct link to the Vimeo video.

URL for Embedding—This variable output contains the HTML code used to embed your video 
within another web page or document. See Embed option above.

HTML embedded code example using URL for Embedding variable:

<iframe width="640" height="360" src="[URL for Embedding]" 
frameborder="0" allowfullscreen></iframe>

VideoID—This variable contains the Video ID of your Vimeo media. The Video ID is a unique 
identifier linked to your video. It can be used to create links or for creating HTML code to embed 
your video within another web page or document.

URL examples: https://vimeo.com/[Video ID]

HTML Embedded code example:

<iframe src="https://player.vimeo.com/video/[Video ID]" width="640" 
height="360" frameborder="0" webkitallowfullscreen mozallowfullscreen 
allowfullscreen></iframe>

Thumbnail—This variable output contains a link to a thumbnail JPEG image generated by 
Vimeo.
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LinkedIn
LinkedIn does not allow for direct media file uploads, but instead expects a URL link to media 
on another site such as YouTube or Vimeo.

Comment—Enter the comment to include with this post. The maximum is 100 characters.

Title—Enter the title of this post. The maximum is 100 characters.

Description—Enter the description of this post. The maximum is 5000 characters and 
truncates at that number. Spaces count as 2 characters.

Submitted URL—Enter the URL of the media that will be linked-to in this post. This URL can 
generate as an output variable from a previous YouTube or Vimeo Deploy action.

Image URL—Enter the URL of a JPEG image that will be linked-to in this post. This URL can 
generate as an output variable from a previous YouTube or Vimeo Deploy action.

Company—Select the company identifier from the drop-down list. This list is generated by 
your LinkedIn account.

Security Code—Click Get Security Code to acquire a security code token providing 
authentication to upload media to a LinkedIn account. To acquire a security code you must sign 
into a LinkedIn account using the account's username, email, and associated password. Enter 
these when the LinkedIn sign-in dialog appears. If you receive a note from the social media site 
that you need to enable cookies, you must use Internet Explorer > Tools > Internet Options > 
Security to set the Internet Security level to Medium so that cookies are enabled.

After you have signed in, a LinkedIn Authentication dialog will open. Click Allow and then OK to 
acquire a security code token. This is a one-time requirement during configuration or when 
your account credentials changes. The security code token is stored with the workflow in the 
Vantage database and used each time a job is run.

To sign out or select a different account, open the drop-down menu in the upper right corner of 
the LinkedIn Authentication dialog.

Important: The Clear Security Information button removes Security Codes from the action. 
Consider using this feature before exporting your workflow to avoid sharing your security 
information, which is visible as clear text in the exported XML file.
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Example Workflow Descriptions
The Example Workflows described here will give you a good overview of how to implement 
your own Social Media workflows. All examples, including associated media and metadata, can 
be downloaded from the Vantage support page at www.telestream.net/telestream-support/
vantage/workflow-examples.htm.

Example Workflow: Social Media—Watch and Associate
A sample workflow you can use to deploy to social media uses Watch and Associate actions. 
This workflow extracts external metadata contained in an XML file and populates this data into 
a Social Media label which is forwarded for use in the Deploy action.

This workflow requires the addition of the Vantage Metadata Conversion (V-METADATA-SW) 
option.

Watch Action
The Watch action will submit media files matching specific parameters upon arrival in the 
monitored folder.

Associate Action
The Associate action associates an additional file with the media file acquired through the 
Watch Action. In the case of this workflow, the associated file is XML, containing metadata used 
to populate the Social Media metadata fields within the Deploy action. 

For this workflow the XML file should have the same base name as the media file obtained from 
the Watch action, however, the file extensions will be different, such .mov and .xml. The 
workflow proceeds only when both the Watch action and Associate action have successfully 
acquired their respective files.

http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
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Transform Action
The Transform action uses a custom XSLT stylesheet to transform the metadata values 
contained in the incoming XML metadata file into their respective Vantage label metadata 
fields. 

Populate Action
The Populate action takes the metadata contained in the Vantage label created in the 
Transform action and populates the Social Media variables. Now that all of the Social Media 
variables are populated with the external metadata values acquired from the XML, the 
workflow can be forwarded for processing.
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Forward Action
The Forward action takes the media and metadata obtained, and forwards it to our main Social 
Media process/deploy workflow. See Example Workflow: Receive and Deploy to Multiple Sites. 

For more information about the actions used in this workflow see the Vantage Actions chapter 
in the Vantage User Guide— www.telestream.net/pdfs/user-guides/Vantage-UserGuides/
Vantage-User-Guide.pdf. 

Additionally, learn more about how to transform XML using XSLT by reviewing 
www.telestream.net/pdfs/app-notes/app_Vantage_Ingest_XML_into_Label.pdf.

http://www.telestream.net/pdfs/app-notes/app_Vantage_Ingest_XML_into_Label.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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Example Workflow: Social Media—Workorder
Another method you can use to ingest media and external metadata into a workflow is by 
using a Workorder action. Workorder actions use workorder schemes (created using the 
Vantage Management Console) to describe how data contained in a workorder file is to be 
parsed and used within the workflow. A workorder file contains the path to a media file and any 
other metadata that may be required for the workflow. 

Workorder Action
The Workorder action is similar to a Watch action with additional capability for extracting 
metadata from a submitted workorder file. This action accepts only properly formatted 
workorder files. Workorder files are text files containing metadata in a comma-separated value 
format (CSV). The structure of data contained in the workorder file is defined by a workorder 
scheme, which is configured using the Vantage Management Console. The sample workflow 
package includes a YouTube sample workorder file and associated workorder scheme.
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Populate Action
The Populate action takes the metadata values contained in the Vantage label passed into the 
workflow by the Workorder, and populates the respective Social Media variables. Now that all 
of the Social Media variables are populated with the external metadata values acquired from 
the Workorder, the workflow can be forwarded for processing.

Forward Action
The Forward action takes the media and metadata obtained, and forwards it to our main Social 
Media process/deploy workflow. See Example Workflow: Receive and Deploy to Multiple Sites.

For more information about the Workorder action used in this workflow, see the Vantage 
Actions chapter in the Vantage User Guide—http://www.telestream.net/pdfs/user-guides/
Vantage-UserGuides/Vantage-User-Guide.pdf. 

For step-by-step details explaining how to create a workorder scheme, refer to the Vantage 
Domain Management Guide, Fulfillment Schemes > Workorder Schemes topic. Workorder 
Schemes are created using the Vantage Management Console > Fulfillment Schemes > 
Workorder Schemes window.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Example Workflow: Receive and Deploy to Multiple Sites
The following example workflow receives files and deploy to multiple social media sites. 
Workflows that begin with a Receive action (figure below) are designed to receive media files, 
Vantage metadata labels and Vantage attachment files from other workflows or applications. In 
our examples the Receive action accepts input from Vantage workflows using a Forward action. 
Other methods of submitting to a Receive action are via the Pipeline Control for Windows 
Vantage plug-in, from a Vantage Workflow Portal, or from a Vantage SDK-based custom 
application. You can also open the workflow in the Workflow Designer and submit a job directly 
from there.

Receive Action
The Receive action is very simple to configure. In the Inspector, you specify the Original file 
nickname and the Social Media label. The Attachments selection is not used in our example 
workflow. 

Populate Action
The Populate action takes the metadata contained in the Vantage label passed to it by the 
Receive action and populates the Social Media variables. Now that all of the Social Media 
variables are populated with the metadata values passed to it by the Receive action, the 
workflow can proceed to the Flip and Deploy actions.
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Flip Actions
Two Flip actions follow the Populate action. One Flip action is configured to make a media file 
appropriate for YouTube and Vimeo, and the other creates a media file for Twitter. The Twitter 
Flip action creates a file that is no longer than 30 seconds (see Twitter media file requirements).

Twitter
Several analysis actions follow the Twitter media file Flip action. The results of the analysis are 
then checked to assure that the file created meets the Twitter requirements. If the file meets the 
requirements it is sent to Twitter using a Deploy action.

YouTube
A Flip action creates a YouTube compatible media file, which is consumed by a Deploy action. 
The Deploy action sends the media file to YouTube. Upon completion the Deploy action 
outputs YouTube URL and Thumbnail variables which are then passed onto a Deploy action for 
delivery to LinkedIn.

YouTube/Vimeo
A common media file can be delivered to YouTube and Vimeo by a Deploy action. The Deploy 
action sending to YouTube outputs a URL variable that is then used to send a post to LinkedIn.

Message Action
The final action in the workflow is a Message action that sends an email containing the Job 
Name and Job Message, as well as any output variables from upstream Deploy action.

Submit from Live or Capture
Live or captured signals can be submitted or streamed to social media by Vantage from a 
Pipeline or Lightspeed Live Capture system. The Vantage publish plug-in can submit directly to 
a Vantage workflow containing a Receive action at its origin. Depending on configuration the 
workflow can add metadata or captions and publish social media stills or video in whatever 
format is required by the social media site.

For more information, see the Pipeline User Guide for Windows—http://www.telestream.net/
download-files/pipeline/guides/PipelineUG-Win.pdf or see the Lightspeed Live Capture Guide—
http://www.telestream.net/pdfs/user-guides/Lightspeed-UserGuides/Lightspeed-Live-
Guide.pdf.

http://www.telestream.net/pdfs/user-guides/Lightspeed-UserGuides/Lightspeed-Live-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Lightspeed-UserGuides/Lightspeed-Live-Guide.pdf
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Submit Using the Vantage Workflow Portal
In order to use the Vantage Workflow Portal you must first register the Social Media Jobs 
catalog with media assets. To register media into the catalog, use the Ingest into Social Media 
Catalog sample workflow to process the demo media. See the next example for details. 

1. With one, or more, assets available in the Social Media Jobs catalog you can open the Social 
Media Workflow Portal and submit to YouTube with associated metadata.

2. Open the Workflow Portal application and select Change/Reload Application 
Configuration… from the File menu.

3. In the Select Configuration dialog select the Social Media Work configuration.

4. Select the clip you want to deploy, and then select the workflow you want to submit the 
media file to from the Forward to Workflows tabs, and then click Submit. 

5. In the Submit Jobs dialog select the Social Media metadata label, fill in the data fields and 
then click Submit.

6. Your job is will be submitted to the workflow you selected with all the associated metadata.

This workflow requires the addition of Vantage Metadata Conversion (V-METADATA-SW) and 
Vantage Workflow Portal (V-PORTAL) options.
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Example Workflows: Using the Workflow Portal
Social media workflows can be managed by an operator using the Workflow Portal to select the 
media files and direct the output to an output workflow for posting to Social Media. The 
following workflows and Workflow Portal steps describe how this process works.

Ingest and Register Workflow
The process begins by using an ingest workflow to pick up the media file from a specified 
location and register it. This preliminary process is necessary before you can view and work 
with the file in the Workflow Portal. The following figure shows the workflow for the ingest into 
the social media catalog. 

Ingest into Social Media Catalog Workflow

Watch Action

The Watch action will submit media files matching specific parameters upon arrival in the 
monitored folder.

Flip Actions

Two Flip actions follow the Watch action. One to transcode the media file into a thumbnail and 
another to create a proxy file. The thumbnail file provides an icon representing the media, 
which is displayed in the Workflow Portal upper panel. The proxy file provides the operator 
with a smaller media file to manipulate in the Workflow Portal (smaller files can be displayed 
and manipulated more quickly) and then Vantage automatically applies the proxy file changes 
to the full-sized output file.
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Populate

The Populate action extracts the Social Media label so it can be added to the asset when 
registered into the Social Media catalog (see Register below).

Register

The Register action registers a media asset into the Social Media catalog. Included in the 
registered asset is the original media file acquired by the Watch action, the thumbnail image 
created by the first Flip action and the media proxy file created by the second Flip action.

Using the Vantage Workflow Portal
You can use the Vantage Workflow Portal to select media files in a catalog, and submit them to 
a Social Media output workflow such as the Receive workflow described earlier. The output 
workflow posts the media and metadata to the Vantage Output Workflow for posting to Social 
Media.

To use the Workflow Portal for social media processing, follow these steps:

1. Add a media asset to the Social Media catalog by using the Social Media Ingest Workflow 
described previously.

2. Open the Workflow Portal using the Social Media portal (included in the Social Media 
Workflow Example package) and select the catalog used in the ingest workflow.

3. Select the media file to process. It displays in the media player.

Select the catalog and select the clip
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4. Select the Metadata Labels tab and add your required metadata values.

5. Select the Forward to Workflows tab, and check the Social Media Output workflow or 
workflows to which you want to submit the clip.

6. Finally, click Submit to send the clip to the Social Media workflows you have chosen. When 
submitted, the clip will be processed immediately by the workflows, culminating in posting 
the media and metadata to Social Media.

View metadata on 
Metadata Labels tab

Select output workflow

Click Submit
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Copyright and Trademark Notice
© 2017 Telestream®, LLC. All rights reserved. No part of this publication may be reproduced, 
transmitted, transcribed, altered, or translated into any languages without written permission 
of Telestream, Inc. Information and specifications in this document are subject to change 
without notice and do not represent a commitment on the part of Telestream.

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, ScreenFlow, 
Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, MetaFlip, and Split-and-Stitch are 
registered trademarks and MacCaption, e-Captioning, Pipeline, Post Producer, Tempo, 
TrafficManager, VidChecker, and VOD Producer are trademarks of Telestream, LLC. All other 
trademarks are the property of their respective owners.
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